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The Financial Reporting System (FRS) is a unique data set.  It is superior to simply comparing company annual reports in that companies report in a format, that increases comparability.
Company-level data is confidential and not publicly reported.  Only aggregate data is reported.

Only publicly traded companies are included in the survey, ensuring that FRS data can be compared to public financial disclosures (e.g.,  Annual report and SEC Form 10-K).

Reporting companies benefit by seeing reports that allow them to compare their corporate results to the aggregate of the industry by line of business.

The reporting companies are commonly referred to as the “FRS companies.”
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Although the original members of the reporting group were almost without exception vertically-integrated oil companies, many changes have occurred in the past 20+ years
The members of the FRS include vertically-integrated oil and gas companies, oil and gas producers, refiner/marketers, refiner/wholesalers, energy companies, natural gas companies, and refining(/marketing) joint ventures.
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Although many of the U.S. majors have become more specialized in their operations over the last several years, the operations of the U.S. majors as a group is still varied.
During 1998 the U.S. majors accounted for:

–85 percent of U.S. crude distillation capacity (the increase from 60 percent in 1997 to 85 percent in 1998 was due to the addition of 11 companies, primarily to reverse the erosion of refining/marketing within the group of U.S. majors),

–48 percent of crude oil and NGL production,

–44 percent of natural gas production, and

–7 percent of coal production (after reaching 30 percent in 1988).
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Domestic refining/marketing is a key area for the FRS companies 
FRS domestic refining/marketing data have been of considerable use in EIA reports and to EIA customers

Return on investment is the net income contributed by the line of business divided by the asset base associated with the line of business (in this case net investment in place — net pp&e plus investments and advances to unconsolidated affiliates). 

Simply considering net income could be misleading without additionally considering the magnitude of the assets used to generate it.

The profitability of domestic refining/marketing has been historically low compared to other lines of business, including foreign refining/marketing.
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An illustration of the recent trends in the gross margin, operating costs, and the net margin demonstrates that reductions in operating costs, not raw materials costs, have resulted in increased profitability (see the figure in this presentation entitled “Returns on Investment in Refining/Marketing and Other Operations for U.S. Majors, 1990-1998”).
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The increased sophistication of U.S. refineries allows all refiners, and especially the U.S. majors who tend to have the most sophisticated refineries, to take advantage of increases in the differences between light and heavy crude oil.  
The more sophisticated the refinery, the more easily heavy crude oil can be processed into petroleum products.
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Similarly, sophisticated refineries allow all refiners, including the U.S. majors, to take advantage of price differences between light (e.g., motor gasoline) and heavy (e.g., residual fuel oil) products.  
Thus, the more sophisticated the refinery, the more easily the refiner can pay less for crude oil and receive more for the refined products.
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Essentially no change/increase in petroleum product consumption is expected to occur this year (i.e., 2000) relative to 1999, partially in reaction to the substantial increases in product prices — particularly fuel oil during the winter and motor gasoline this summer.
Consumption of petroleum products is expected to increase next year — so long as the shortages that occurred during the first half of this year don’t recur — by almost 3 percent.

So, the U.S. refining industry has undergone a large amount of change/restructuring during the past decade.  Although the profitability of the industry has been relatively low (at least for the U.S. majors and relative to their other petroleum operations), the future of the industry over the next several months appears stable, if not spectacular.
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This is a PowerPoint presentation made by Dr. John Cook of EIA at the National Governors’ Association on January 26, 2001.  It was subsequently made available on the EIA web site a an html version of the PowerPoint presentation.

The slide at the right is the opening slide on the web site.  The Table of Contents is shown in part.  To view the slides in sequence simply click on “Click here to start”.  Then buttons will appear on the next slide as navigation aids.
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Each slide has accompanying text.  The text for the slide at the right is shown in the picture below.  Note the navigation buttons.  For subsequent slides the navigation buttons will be omitted to conserve space.
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The text accompanying the previous slide is shown at the right.
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Notes:

o Spot WTI prices broke $35 and even $36 per barrel in November as anticipated boosts to world supply from
OPEC and other sources did not show up in actual stocks data.

o The recent decline in prices seems to be more the result of an unraveling of speculative pressures than a change in
underlying fundamentals.

o Prices had been running higher than supply/demand fundamentals would have indicated throughout the fall
months as a result of rising Mideast tensions, concern over the adequacy of distillate supplies, and
expectations of Iraqi supply interruptions.

o But Mideast tensions seemed to ease in December and the market appeared to perceive a quick refurn of
Tragi crude oil supplies at full capacity. Pledges by Saudi Arabia/OPEC to offiet a longer term Iragi
disruption added to a market sense of oversupply.

o Relatively mild weather in Europe allowed distillate stocks to normalize there and has kept crude demand
relatively stable.

o All these factors seemed to refocus speculators on the downside potential for price, at least through
December.

o EIA still sees a very tenuous supply/demand balance. With low inventories, a severe cold snap in Europe and the
U.S. would increase refinery demand for crude, and push prices up. If the Iraqi disruption is thought to be
indefinite, prices could be as high as $3-85/barrel above those shown on this graph.

o However, EIA believes the market will move toward a more typical balance during 2001 and that prices will
remain around $30 per barrel until the middle of the year, as the match of supply and demand improves.
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Despite more than a doubling of average world crude oil prices from 1998 to 2000, prices remain well below the peaks seen in the early 1980’s, both on a nominal and a real (constant dollar) basis.
The average world crude oil price (represented by the average price paid by U.S. refiners for foreign crude oil) in 2000 is estimated by EIA at $27.86 per barrel.  By comparison, the peak annual average world price was $37.05 per barrel in 1981, equivalent to $59.40 per barrel in 1999 dollars.
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EIA assumes in its base case that OPEC 10 production averages about 0.6 million barrels per day less in the 1st quarter of 2001 than was produced in the 4th quarter of 2000.  This is based on the assumption that beginning in February 2001, OPEC 10 production is 1 million barrels per day less than the estimate for December 2000.
From the fourth quarter of 1999 to the 4th quarter of 2000, worldwide oil production increased by about 3.7 million barrels per day to a level of 77.8 million barrels per day.

Etc.  more assumptions and observations.
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During 1999, we saw stock draws during the summer months, when we normally see stock builds, and very large stock draws during the winter of 1999/2000.  
–Normally, crude oil production exceeds product demand in the spring and summer, and stocks build.  

–These stocks are subsequently drawn down during the fourth and first quarters (dark blue areas).  When the market is in balance, the stock builds equal the draws.

–
During 2000, stocks have gradually built, but following the large stock draws of 1999, inventories needed to have been built more to get back to normal levels.

Etc.
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The most recent data show OECD inventories remaining at very low levels. 
EIA expects inventories to remain low through the coming year.  This increases the potential for price volatility through the winter, and even extending to the next gasoline season.
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One can use a simple model to deal with price/fundamental relationships.  This one predicts monthly average WTI price as a function of OECD total petroleum stock deviations from the normal levels .
–The graph shows the model as it begins predicting prices in 1992.  It shows how well the model has predicted not only the direction, but the magnitude of prices over this 8+ year period.

While the model is simple and not perfect, it does predict the overall trends and, in particular, the recent rise in prices. 
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Consistent with OECD inventories, U.S. inventories are low.  They have been well below the normal range for over one year.
Crude oil stocks in the United States, while tending to increase of late toward more normal levels, remain well below average.  At the end of December, crude oil stocks were near 289 million barrels, about 4% below the 5-year average, and slightly higher than at the end of 1999.  The latest weekly data, for the week ending January 19, show U.S. crude oil stocks at 286 million barrels, just about a million barrels above their level a year ago.
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At the end of December, distillate fuel oil stocks were about 116 million barrels, which is more than 14 percent below their 5-year average for this time of year, and about 7 percent less than last year’s low levels.   As of January 19, the most recent weekly data, distillate stocks remained at about that level, which is slightly higher than a year ago.
If the currently depressed level of distillate stocks continues, the result could be strong upward pressure on prices for the distillate fuels through the winter.  
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Stocks are normally an important part of East Coast winter distillate supply, since they are the nearest source when anything unexpected occurs, and they supply a significant portion of demand during the peak heating season.  Over the last 10 years, stocks have provided about 15% of supply during the peak winter months of January and February.  On average, stocks supply the East Coast with about 260 thousand barrels per day in January and 280 in February.  Those supplies represent draws of about 8 million barrels in one month.  
In addition, East Coast refineries meet about 25% of demand during January and February, and other regions -- mostly the Gulf Coast -- supply 40-50% of the region’s needs.
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Because of the higher projected crude oil prices and because of increased tightening in the Northeast heating oil market since the last Outlook, we now expect prices this winter for residential heating oil deliveries to peak at about $1.52 per gallon in January.  This is significantly above the monthly peak reached last winter.  Because these figures are monthly averages, we expect some price movements for a few days to be above the values shown on the graph.
This winter’s expected peak price would be the highest on record in nominal terms, eclipsing the high set in February 2000.  However, in real (constant dollar) terms, both of these prices remain well below the peak reached in March 1981, when the average residential heating oil price was $1.29 per gallon, equivalent to over $2.50 per gallon today.
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Gasoline inventories in the United States began last summer’s driving season at low levels and ended at low levels.  
In October 2000, with the market focusing on distillate, gasoline inventories slipped well below the normal range.  

At the end of December, gasoline inventories were about 194 million barrels, which is almost 5 percent below the 5-year average level for this time of year, but slightly above the end of 1999.  As of January 19, the most recent weekly data, gasoline stocks have risen to nearly 201 million barrels, about a million barrels less than a year ago.
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Assuming that our base case crude oil price path holds, we project that retail motor gasoline prices will continue to recede this winter, then begin to rise ahead of the summer driving season. By year's end, the monthly average retail price of regular unleaded (self-service) motor gasoline is projected to be about $1.38 per gallon.
As was the case with heating oil, last year’s peak average gasoline price, at $1.633 per gallon in June, was the highest ever recorded in nominal terms.  However, in real (constant dollar) prices, the highest observed price was in March 1981, when the average was $1.417 per gallon, equivalent to almost $2.80 per gallon today.
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U.S. inventories of propane benefited from a late pre-season build that pushed inventories to over 65 million barrels by early November 2000, the second highest peak pre-heating season level since 1986. 
Although propane inventories were expected to remain within the normal range for the duration of the 2000-01 heating season, cold weather in November and December, along with recently high natural gas prices that discouraged propane production from gas processing, resulted in stocks falling below the normal range by the end of December.
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Propane spot prices at the major trading hubs remained relatively close through the fall of 2000, even as they were pushed higher by rapidly rising natural gas prices. 
Prices in the entire country experienced a rapid runup in December as demand increased (due to unusually cold weather) and supply was constrained (due to refiners using propane in their own facilities and natural gas processing plants offering less propane for sale as natural gas prices remained extraordinarily high).

Residential propane prices are expected to rise over the remainder of the 2000-01 heating season as continued volatility in crude oil markets and strong heating demand put upward pressure on propane prices during this period.
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Residential propane prices rose fairly strongly during the 1999-2000 heating season, gaining nearly 25 cents per gallon between October and March.
Unfortunately, increases have been even stronger this year.  EIA’s winter residential propane price survey shows that prices started out this season higher than they ended last spring, and have risen sharply from there.  Average prices in the East and Midwest have risen more than 40 cents since the season began in October.

As seen in the previous chart, recent moderating of natural gas prices has helped bring spot propane prices down somewhat from their peaks in early January.  If this trend continues, residential prices should flatten out or begin to decline.
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Working gas in storage is estimated to have been about 2,425 billion cubic feet at the end of November, 14% below the previous 5-year average.  The current outlook for winter demand and supply suggests that storage is headed for record lows this winter if weather is normal or colder than normal.  In the base case, we project that gas storage will fall to about 640 billion cubic feet at the end of the heating season (March 31, 2001).  The previous record low was 758 billion cubic feet at the end of the winter of 1995-1996.  If summer gas demand next year is as strong as we currently expect it to be, the low end-winter storage levels will present a strong challenge to the North American gas supply system to maintain flexibility and provide additional gas in preparation for the subsequent winter season.
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The surge in spot prices at the Henry Hub since April has taken prices well above a typical range for 1998-1999  
 The Henry Hub spot price spiked at $10.53 per MMBtu on December 29.
 SReasons for the price run-up include:
–relatively flat natural gas production for several years

–increased demand for natural gas as the economy has grown, especially from the electricity generating sector

–expectations for a colder winter than experienced in the last few years (generally borne out so far this heating season)

–low levels of natural gas in storage

–high prices for oil limiting the economic incentive to switch to petroleum-based fuels.
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We expect to see peak monthly spot wellhead prices this winter of over  $8.40, the monthly average reported for December 2000.  Recently, concern about cold weather and low stocks pushed daily spot gas prices over $10.50  per mcf.  However, in early January of this year, forecasts of warm weather pushed the price down by more $1.00 per mcf in one day, indicating the extraordinary volatility in the current U.S. market.
The gas storage situation in the United States has not improved over the last few months, a sign that demand remains strong.  We believe that the 30-year records for (seasonally adjusted) storage lows may be challenged throughout the heating season.
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PowerPoint Tutorial

Adapted from Media Services:  http://www.eiu.edu/~mediasrv/ppoint97/PowerPoint.html  and Energy Information Administration – Henry Weigel, Presented in Bangladesh March 1, 2001

1.  Creating a New Presentation
When PowerPoint first opens, there are four choices on how to create a new presentation. You can select AutoContent wizard, Template, Blank presentation or Open an existing presentation.  AutoContent wizard will create a presentation for you using your specifications.  Once you are finished, you need to substitute the text they have entered with your own text.  Template gives you the background and formatting for the presentation, and a Blank presentation begins with one blank slide.  Open an existing presentation allows you to open a presentation that has been previously saved. 

	Choose by clicking the bullet to the left of the option you would like to use. For now, select Blank presentation and click OK. 


	



	In the next screen, the computer asks you to choose an AutoLayout. The AutoLayout defines the type of slide you are going to insert in your new presentation. There are numerous types of slides including bullet slides, organizational charts, and tables. For now, choose the blank screen and click OK. 


	



Your screen should now display a blank slide on which you can begin to enter text and graphics. 

2.  Inserting a New Slide
Now that you have a blank presentation with one blank slide, let's add another slide. The main menu is located at the top of PowerPoint's screen (and shown here). Go to the main menu and click the Insert menu.

	Move the cursor down to New Slide and click. Typing the letter M while holding the Ctrl key down will also add a slide. You may use either option.
	



	The AutoLayout screen should appear. Choose the blank screen and click OK.

A blank screen will appear. Move on to Lesson 3 to add text to the slides. 


	



3.  Entering Text Into Your Presentation
Now that you have a blank presentation with one slide, let's enter some text. There are two ways to enter text: text box and word art.

Using the Text Box

The text box is the best option for larger text passages or text which needs to be edited easily.  Go to the main menu and select the insert menu. Under the Insert menu, choose text box. 
  After you have chosen the text box option, press the cursor down where you would like the text to appear, and hold the cursor down as you drag the text box longer. Make the box as long as you like.  

Editing Text

To edit this text, highlight it by dragging the mouse over it while holding down the mouse button. The text should appear highlighted as shown here.  

In the main menu, select the format menu as shown here.  

In the format menu, select font.  

	The font screen should appear (as shown. Here, you can choose a font, style, size, effect and color for your highlighted text. Under the Font menu, choose Arial Black as I have highlighted. You can choose this font by clicking on it. Once it has been chosen, it will appear highlighted.
	



	Under Font style, choose Bold as I have highlighted above. The bold option will make the text appear darker than any other option. Once you have chosen the Font and Style (Arial Black and Bold), click OK. The text should look different now. The text after this editing is shown at right.
	



	In the main menu, go back to the format menu and select Font again. When the Font screen appears, change the style to Italic rather than Bold. 

Under the Size menu, select 60. Since 60 is larger than our previous font size, the size of our text will increase. 

Once you have made your selections, click OK. The text box enlarges to accommodate the larger font.
	



	Once more, go to the Font screen (under the Format menu select font). Under effects, select the box next to Underline. A check should appear in it as shown at right.

Under Color, press the arrow ( ). Choose the color blue by clicking on it.
	



	Once you have finished, click OK. The text should now look like this: 

Now, we can move on to adding WordArt.


	



Using WordArt

WordArt can be used to create interesting headings or flashy titles.  Under the insert menu, select picture. In the submenu that appears, select WordArt. 



Select a type of WordArt. For this tutorial, choose the rainbow style as outlined in the picture below. Once you have selected it, click OK. 



	In the next screen, type in a word or short phrase. Click OK when you are finished. This is what it should look like:  
	



Editing WordArt

	Double click on your WordArt to get back to the menu where you added your WordArt text. This is where you can edit your WordArt. 

To change the font size, click the arrow under the Size menu as shown. From the menu that appears, select the number 54. Now, your WordArt will have font size 54. 

The bold option is represented by a letter B on the button face at the top of the screen. Select this option. You may also use the italic option by clicking the I which is next to the B button. 
	



	Now, we can change the font to Bookman Old Style by pulling down the menu with the arrow button ( ). Keep the mouse button down until you have Bookman Old Style, then release the button. 

Once you have finished editing your WordArt, click OK. 
	



	You now have two types of text on your screen; text box and WordArt. 

Now that we have text, we can move on to the next lesson to insert and edit pictures.


	



4.  Inserting and Editing a Picture

Inserting a Clipart: 

	Go up to the main menu and click the insert menu.  Under the insert menu, choose picture then clip art. 


	


	In the Microsoft Clip Gallery (shown at right) make sure the Clip Art tab is selected. Choose a category from the left. Select Gestures. 

Now, you can select one of the graphics displayed on the screen. If you would like more options, you can press the world icon. The computer will let you choose an icon from a homepage it brings up. This option is only available if you are connected to the Internet and have access to the web. 


	



	Once you have made your selection, click Insert. 

The graphic should now appear on screen.


	



	Editing a Picture:

Click the right mouse button on the picture and a menu will appear. Select Format Picture. 


	



	 In the Format Picture screen, the Colors and Lines tab should be selected. 

The Fill refers to the background behind the picture. Press the arrow (
) to bring down the possible colors. Select a color by clicking the mouse button on that color. 

Using the same technique, the line options can be changed. To the right of the word Color, the text should say "No Fill." Click the arrow (
) and a menu will appear (as shown at right). Select a color by clicking on it. 


	



	You can also change the type of line under the Dashed menu as shown. Select the second one down -- the "Round Dot."

Next, the line style can be changed. Click the arrow (
) next to Style and choose 3 pt as shown at right.

Once you have made your selections, click OK.
	



Moving and Resizing

At this point, it is possible that your text and clip art appears as shown below. To move graphics or text, click the object you want to move. While holding the button down, drag the object to the desired location. Release the mouse button to complete the move. 

	Try to move the clip art to the bottom-left corner of the screen using this procedure. 

To resize an object, move the cursor to the edge of the object that you want to change. A two-headed cursor will appear.  While the cursor is a two-headed arrow, hold the left mouse button down and drag the cursor to the desired size. 
	



5.  Adding Animation

	In the main menu, click Slide Show. 

Under the Slide Show menu, click Custom Animation as highlighted. 

The Custom Animation screen should appear. 
	



	Click the Timing tab if it is not already selected. 

Under the section Slide objects without animation, click WordArt. WordArt is shown highlighted.
	


	Under the section Start animation, click the bullet to the left of Animate. 

Under Animation order, you can see WordArt listed as number one. This is the only item being animated, so it is listed as the first item in the animation order.


	



Change the Tab to the Effects Tab. 

	Under Entry animation and sound, click the first down arrow 
 Select Spiral.

In the second section under Entry animation and sound, click the down arrow. Select Drive By

Under the After animation section, click the down arrow button 
. Click Hide After Animation. 

Click Preview to see what the animation will do to your WordArt.

Once you are finished, click OK.
	



6.  Adding Sound
Inserting Sound

	In the main menu, click Insert. 

Under the Insert menu, click Movies and Sounds as highlighted.
	

	The Movies and Sounds submenu should appear. Click Sound from File as highlighted at right.
	



The Insert Sound screen appears. If you are not already in the Media folder, click the down arrow button (
) which is located to the right of the text Look in. 



In the C drive, go to the Windows directory and click the Media folder. The screen that appears gives a list of sound files.  Select one by double clicking, say, Jungle Maximize.wav and click OK. You can tell that Jungle Maximize.wav is a sound file because it ends with .wav. There are three types of sound files you can use in PowerPoint: .midi, .rmi and .wav. 

After you have double-clicked Jungle Maximize.wav, a sound icon should appear in the center of your screen.  Click on the Sound icon. Continue to hold the mouse button down and drag the icon to the bottom right corner of the screen. Now, the icon is not blocking any words or graphics. 

Animating Sound



	Click the sound icon using the right mouse button. A menu should appear as shown at right. Click Custom Animation. 

The Custom Animation screen should appear. Make sure the Play Settings tab is selected. The tab is boxed in red below. 


	



	Click the box to the left of Play using animation order. This option will allow your sound to begin after the other objects are animated because it is currently last in the animation order. 

Once you are finished, click OK.


	



7.  Adding Video
Inserting Video

	In the main menu, click Insert. 

Under the Insert menu, click Movies and Sounds as highlighted. 
	

	The Movies and Sounds submenu should appear. Click Movie from File as highlighted at right.

The Insert Movie screen appears.
	



	If you are not already in the Help folder, click the down arrow button (
) which is located to the right of the text Look in. 

In the C drive, go to the Windows directory and click the Help folder. The screen should look like the one displayed at right. 
	



 

	A list of movies ending in .avi appears.  Double-click to select one, say, Whatson.avi.

After you have double-clicked Whatson.avi, a movie icon (a rectangle) should appear in the center of your screen.

Click on the Video icon.  Hold the mouse button down and drag the icon to the top right corner of the screen as shown at right. Now, the icon is not blocking any words or graphics. You can double-click the movie icon to see the movie.
	



	Editing Video

Click the video icon using the right mouse button. A menu should appear as shown at right. Click Custom Animation. 

The Custom Animation screen should appear (shown below). Make sure the Play Settings tab is selected. 


	



	Click the box to the left of Play using animation order. This option will allow your sound to begin after the other objects are animated because it is currently last in the animation order. 

On the right side of the screen, click the box next to Hide while not playing. This will hide the video icon at all times except when the computer is playing the video. 

Once you are finished, click OK.
	



8.  Inserting a chart 

There are two different ways to insert a chart. You can insert object or insert chart. Using the Insert Chart command requires less steps, but the object command is necessary to import a spreadsheet or graph from another program into a PowerPoint document. After the chart has been inserted, it can be edited the same way.

	Insert chart
In the main menu, click the Insert menu.  Click New Slide. This will allow the chart we will insert to be on a page by itself.

Select Blank Page. Click OK.

Under the Insert menu, click Chart.  A chart and data sheet should appear.
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	Enter data in the Datasheet. Replace their data with numbers and labels of your own. You are welcome to add an extra column or row of data if you would like.

Here we have entered the consumption data for Bangladesh in quadrillion Btus (Quads) 

Once you have entered the data, click the close box 
on the Datasheet screen. This will close your spreadsheet.
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	Insert object:

Use a new slide, insert a chart with Insert Object. Under the insert menu, choose Object. The Insert Object screen will appear. Select Create new. This creates a new graph rather than using previously saved data. 

Under Object type, select Microsoft Graph 97 Chart as shown at right. You may have to scroll down in order to find it. Click OK.

Close the spreadsheet to use their data rather than replacing it with your own data.
	



	A more straightforward way is to generate the graph in the Excel Spreadsheet; for example, the Oil and Gas Consumption for Bangladesh. 

1. Select and copy (from the Edit menu); then go to the blank PowerPoint slide and Edit, Paste.

2. If the graph has been saved as a gif or jpeg file then from the Menu use click on Insert, then Picture, from File.
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	Editing Your Graph

In the main menu, click the Chart menu. 

You can change the type of graph by selecting Chart Type under the Chart menu.

In the Chart Type menu, the Standard Types tab should be selected.  Pick the Area type of chart from the left column of options.  On the right, you can choose from the Chart sub-type menu. Choose the Stacked Area, which is the middle chart in the top row.  If you press down the Press and hold to view sample button, you will see what your graph will look like.  Once you have selected a type of graph, click OK.


	


  





9.  Creating Slide Transitions

In the main menu, click Slide Show.  

	In the Slide Show menu, click Slide Transition. 


	

	The Slide Transition screen should appear. Under Effect, click the down arrow (
) next to where it says No Transition. 

Click Fade Through Black You may have to scroll down to find it.
	


	When you clicked Fade Through Black, the picture on the right side of the screen faded through black to show what the option looks like. Click the picture to see it again.

There are three speeds in the middle of the right side of the screen. Select Slow as shown at right. 

Under Advance, click Only on mouse click if it is not already selected. This option will allow you to click the mouse button to activate the slide transition.

Under Sound, click the down arrow (
) next to [No Sound]. Click Whoosh in the Sound menu as highlighted at right.  Click Apply. This will apply the transition we have selected to the slide we are on in our presentation. Apply to All will cause all of the slides to have this transition. 
	



10.  Creating a Master Slide from a Design Template 

A Design Template is a presentation with a consistent appearance in color and form. It has the ending .pot in the file name.  A variety of these exist in PowerPoint.  This type of file can help give future presentations the same consistent look and is the starting point for creating a Master Slide.

	Creating a New Presentation In the main menu, click File.  In the menu that appears, click New. The New Presentation screen should appear.

Double-click the Blank Presentation icon.  The New Slide screen should appear. Click the Title Slide icon as highlighted.  Click OK.


	



	 The first slide in your blank presentation should have the boxes displayed as shown at right.

Where it says Click to add title, type Master Slide.  Type Creating the Master Slide where it says Click to add a sub-title. 
	



	Select the Template

In the main menu, click Format. 

In the Format menu, click Apply Design Template. 

Select Blends.pot. 
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	The Blends.pot template results in the Master Slide shown below.  To edit the Master go to the View Menu, then Master, then Title Master.
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	Raise the design pattern and add special icons.
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	Naming and Saving Your Master Slide 

Under the main menu, click File. 

Under the File menu, click Save as, then select a directory, and give it a name.


	



	Apply the  Master Slide to creating a presentation.  Open the PPT file that has the Master, as shown at right.  Do a Save As to give a different name, so that the original does not get destroyed.
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	In the Main Menu click on Insert, New Slide.  Select the slide style and click OK.  See below.
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	Paste Excel graphs into it.
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	 Repeat the Insert, New Slide process.

Enter descriptive text in the Title bar and copy Excel graph into the slide.

You also can Insert, Picture –from File and insert a gif or a jpeg picture or graph.

Resize the graph to fit by selecting the graph and dragging the corners.
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11.  Viewing Your Slides

There are five different ways to view your slides. So far in this tutorial, we have been viewing them in slide form. These next forms will show the same slides we have created in different ways.

Outline View 

	Under the view menu, select Outline.  This is a text view. The 
indicates the beginning of the first slide. The number before the slide symbol indicates the slide number. You can add text in outline view and it will appear on your slide.
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Normal View

	The Normal View is much like the Outline View.  The slide picture is larger.  In fact, you can get from one to the other by simply resizing the windows of the outline, the slide, and the notes.  The resizing can be done by clicking on the boundary of a window and dragging it to the desired size. 
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Slide Sorter

Under the view menu, select Slide Sorter. This view allows you to change the order your slides are presented in.  Click the mouse button on the first slide and hold it down as you move the cursor to the right until a line appears on the right side of the second slide. Release the mouse button, and the slides change places.
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Notes Page

	Under the view menu, select Notes Page. 

Here you can add any notes to your presentation that you may need as a presenter but do not want to appear on the slides. You may want to increase the font size before you type. The notes screen is a reduced view.
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Slide Show

	Under view, select Slide Show. The menus and toolbars have disappeared to show a full view of the first slide. Click the left mouse button once to move to the next slide. To end the slide show, click the right mouse button. In the menu that appears, select End Show. 

Start the slide show again. Press the right mouse button once.  In the menu that appears, select pen. You may use this pen as a pointer. If you hold the left mouse button down, it will draw. The markings made by the pen will be erased automatically at the end of the slide show. Press the right mouse button. From the menu, choose End Show.
	

	



12.  Putting Your Presentation on the Web 

Saving your presentation as a Web Page (as in MS Office 2000) 

	In the main menu, click File.  In the File menu, click Save as Web Page, see at right.

The Save As Menu (see below) appears. Clicking on Save will save it as a web page.  But clicking on the button labeled Publish gives additional options, bringing up the Publish as Web Page Menu (below, right). Select the complete presentation or some of the slides.  Also select the Browser Support you desire.  Then Click on Publish at the bottom of the menu.
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The resulting web representation of the PowerPoint presentation is shown in the following sequence.

	The first slide in the web page of the PowerPoint presentation is shown at the right.

Note the Table of contents in the darkened bar on the left.

Note the navigation buttons at the bottom:

<< Slide 1 of 3 >>
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	The second slide, shown here, has its title highlighted in the Table of Contents and at the bottom has the navigation buttons:

<< Slide 2 of 3 >>

Clicking the left arrow takes you to slide 1, and the right arrow to slide 3.
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	Slide 3 of 3.

Note that the design of the Master Slide appears on all slides.
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Saving your presentation as HTML (as in MS Office 97). 

The following sequence of Menus gives the MS Office 97 PowerPoint method of saving the PPT file as an HTML files.

	In the main menu, click File.  In the File menu, click Save as HTML, see below.



The Save as HTML screen should appear as shown at right.
	




	The next few screens will prepare your presentation for the internet. This is the introduction screen. Click Next.

This screen allows you to choose a layout to apply to your presentation. Click the bullet next to New layout. Click Next.


	



	Select the page style by clicking the bullet to the left of the word Standard. Click Next.


	



	There are three options for Choose Graphic Type. GIF graphics often take up more memory than JPEG graphics, so JPEG is the recommended choice. If you have the PowerPoint Animation Player, PowerPoint animation graphics will show your animation and slide transitions. Since most people do not have the PowerPoint Animation Player, click the bullet to the left of JPEG. Click Next.


	



	For monitor resolution, click the bullet to the left of 640 by 480. This will allow even low-resolution monitors to see your presentation.  Under Width of graphics, click the down arrow (
) next to where is says 1/2 width of screen. In the menu that appears, click Full width of screen. This will make your slides the size of your screen. Click Next.


	



	If you would like your e-mail address, homepage or other information such as the name of your organization to appear in your presentation, type it in this screen. Click Next.


	



	Click the bullet to the left of Use Browser Colors. This will allow the colors set on your browser to be the background and link colors of the page. This does not effect the colors of your slides. Click Next.


	



	Under Select button style, click the circle button. This is the shape of the navigation buttons that will appear at the bottom of your presentation. These buttons will allow you to go from one slide to the next. Click Next.


	



	This screen allows you to choose where you would like to put your navigation buttons. Find the icon with the buttons located at the bottom of the screen as shown at right. Click the bullet to the left of this icon. Once you are finished, click Next.


	



	In the white box under Folder, type in the folder path you would like your presentation to be saved in. If you are unsure, click Browse to find the folder you are looking for. I am saving my presentation in the path. Once you are finished, click Next.


	



	You are finished setting up your presentation, so click Finish.


	



	The process of saving the presentation as an html file may be saved and given a name. But for now Click Don't Save. It is not necessary to save the choices we have made.


	



Viewing your presentation in your browser 

Close PowerPoint and open your browser such as Netscape or Internet Explorer.

Open your file in your browser. It can be found in the directory you saved it in. Your file is not just one document. It is a folder. Open the one which is called index.htm. Although the colors may be different, the page should look like the one displayed below.



13.  Using the Help Menu 
  


	To learn more about the PowerPoint software, use the help menu. This provides several different ways to find information. The help menu is located in the upper-right hand corner of the screen. Move the cursor to Help, and press down the mouse button. The help menu will appear as shown: 
	



	Using Microsoft PowerPoint Help 

The first option under the help menu is "Microsoft PowerPoint Help." Select this option. 

You should see your helper appear. In most cases this is a paperclip. This is where you can type in the topic you would like to know more about. For this example, type in "saving files." 

Once you have typed it in, press Search.
	


	The next screen to appear is shown at right. It asks which topic you would like to know about. All of these topics are related to saving files. 

If you can not find the topic you are looking for, you can select See more….


	


	Click the bullet next to Save presentations in PowerPoint 95 format. 

The help file will come up. 

Exit out of help by clicking on the 
in the right corner of the screen or pressing Close.
	



   

	Using Contents and Index 

Go to the help menu and select the second option; Contents and Index.  There are three tabs to choose from; Contents, Index and Find. In Contents, you can see a listing with books next to each item.  Double clicking a book will open it and you can see what it contains.

If you click on the index tab, the help index will appear.  We can look for "saving files" again. Simply by typing in the first four letters, the index has found what we are looking for. Some searches require you to type in more letters, but after your topic is highlighted, you can stop typing.  You can use the mouse to select one of the other topics on the screen if you wish.  Select Display to see the help file of the highlighted topic.
	



	Using What's This.  Select the third help option from the menu -- What's This?  A question mark should be attached to the cursor 
. Now, move the cursor to the main menu. Click the insert menu. Under the insert menu, click New Slide. Rather than inserting a new slide, a screen appears which briefly describes the New Slide option.  What's This? gives a brief explanation of the item you click on.
	



In conclusion, one of the best ways to learn a program is not even in the help menu. If you want to try new things, simply try new things. Try to create creative presentations by trying new things. Practice is the best way to learn a program. 
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